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1 TESLA: An Introduction 

1.1 Overview 
TESLA is a software tool designed to aid decision makers.  It has several purposes: 

1. To allow decision makers to assess and record not only evidence that supports or refutes 

a claim, but also any uncertainties that may exist, for example due to lack of knowledge. 

2. To provide a structure for breaking a complex decision down into manageable chunks. 

3. To provide a full audit trail of the information that was used to reach a decision. 

4. To provide decision makers with tools to analyse their decision, allowing them to 

effectively target funds and resources at areas that have the most bearing on the overall 

decision. 

The software uses a form of decision theory called Evidence Support Logic (ESL), which is 

discussed in detail throughout this document. 

Importantly, neither TESLA nor ESL takes the place of the decision maker.  They are simply 

tools that are available to support the decision maker when making complex decisions, and to 

record the details of each decision so that it is robust and defendable. 

1.2 About this Document 
This document is the user guide for the software.  Although it provides an overview of ESL, it 

does not contain details of best practice or how to interpret results.  In addition, as it is intended 

that the software should be both intuitive and user-friendly, this document does not need to 

contain details of every menu or button available on the user interface.  When describing how to 

perform an action using the software, generally only one method will be mentioned - however 

there will often be multiple ways of achieving the same effect (e.g. right-clicking, using a 

keyboard shortcut etc.)  It is suggested that users should explore the software and find the 

method that best suits them. 

As far as possible a consistent terminology has been used throughout this document.  Users 

may wish to refer to the glossary of terms in Appendix B for definitions of the key terms. 

1.3 An Introduction to Evidence Support Logic 

(ESL) 

1.3.1 Differences between ESL and MCDA/MADA 

You may have heard of multi-criteria decision analysis (MCDA, also known as multi-criteria 

decision making or multi-attribute decision analysis (MADA)), a common method applied to 

decisions that involve choosing one option from a number of different options.  For example, 

MCDA could be applied to choose a new car based on which would be most suited to your 

needs: a Ford Mondeo, a Peugeot 407, a Toyota Avensis etc.  Each option (i.e. car) is scored 

based on how well it meets certain criteria, for example comfort, performance, fuel consumption 

etc. 

In contrast to MCDA, ESL is used to study a single hypothesis (e.g. “this car is comfortable”) in 

depth.  Whereas MCDA aims to answer the question “Which option is best?” ESL aims to 
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answer the question “How confident can I be that my hypothesis is true?”  Since the answer to 

the question is quantitative, it is possible to compare the results of the same analysis as applied 

to different scenarios (or cars in this instance). In TESLA this is called a Portfolio Comparison.  

Portfolio comparisons are described in Section 12. 

A second difference between the two methods lies in the evaluation of criteria.  In MCDA, each 

option is usually scored or ranked based on how well it meets the criteria.  In ESL, two numbers 

are entered: the degree of confidence that the hypothesis is true given the evidence supporting 

it and the degree of confidence that the hypothesis is false given the evidence refuting it.  From 

these a third value can be calculated (the degree of uncommitted belief) which expresses either 

the degree of uncertainty arising from a lack of evidence and/or confidence in the evidence, or 

the degree of conflict in the available evidence.  Uncertainty arising from lack of evidence could 

be due to missing research (did you actually try all the seats in the car?) or an inability to collect 

evidence (e.g. it wasn’t possible to test the effectiveness of the windscreen wipers because it 

wasn’t raining on the day of the test drive).  Accounting for uncertainty in a decision, 

understanding how it affects the outcome, and planning how to reduce it are some of the most 

important aspects of ESL. 

1.4 Decision Tree Structure and Terminology 
A decision is typically informed by determining whether some hypothesis is truthful.  For 

example, consider the decision of whether to take an umbrella with you when you leave the 

house.  This is informed by the truthfulness of the hypothesis “It will rain today” (or equally “It will 

not rain today”) - if this hypothesis is determined to be true, an umbrella would be a good idea.  

If it is false, there is probably no need for the umbrella.   

Complex decisions are best solved by breaking the main hypothesis down into a number of 

simpler constituent hypotheses.  These can then be broken down further, until a point is reached 

where some information is known about the lowest level hypotheses.  Consider again the 

problem of deciding whether to take an umbrella with you when you leave the house.  In order to 

determine the truthfulness of the hypothesis “It will rain today” you might do a number of things.  

First of all, you would look outside to see if it is currently raining.  If it is, you will certainly need 

your umbrella!  If it isn’t, you need to consider whether it might rain whilst you are out.  You 

might look at the thickness of the clouds in the sky or look at a forecast given in a newspaper, on 

the television or radio or via the internet.  This simple example shows how information is 

gathered to answer simpler questions, the answers to which are combined to produce a solution 

to the overall question.  TESLA provides a framework for the propagation of this information; 

from the points of knowledge through to the solution of the original problem. 

This framework is known as a Decision Tree, shown below in Figure 1.  Like any other kind of 

tree, it starts at the roots and grows outwards, branching as it does so, and ending at the leaves.  

Each point on the tree is called a Node, and these are points of information - each node 

represents a hypothesis.  There are two special kinds of nodes; the Root Node, of which there 

can only be one, and the Leaf Node, of which there can be many.  Since nodes represent 

hypotheses, these nodes are alternatively referred to as the Root Hypothesis and Leaf 

Hypothesis respectively. 
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Figure 1: The Decision Tree structure.  Nodes represent hypotheses. 

The Root Node, coloured yellow in the figure, is always positioned at the top left of the tree.  It is 

the only node in the tree not to have a Parent – i.e. it does not originate from any other node.  

The root node is the ultimate destination of all the information within the tree; it is here that the 

final solution will be obtained. 

The root node will have one or more Children.  Child nodes are simply nodes that have a parent, 

i.e. they originate from another node.  They may also be parent nodes themselves, if they in turn 

have one or more child nodes of their own.  Thus the tree branches down and to the right 

through a succession of nodes.  Nodes which share the same parent are called Siblings. 

Most nodes will have both a parent and one or more children (coloured orange in the figure).  

However some have no children; these are the second special type of node, known as Leaf 

Nodes.  Leaf nodes are coloured green on the figure above and are always the final node on a 

Branch of the tree.  These are the points where information is input into the tree by the user; 

levels of confidence that the hypotheses are true and false based on the available evidence. 

The information is then propagated up the tree from the leaves to the root using the algorithms 

supplied by a Propagation Method.  As described above, the propagation method employed by 

TESLA is Evidence Support Logic or ESL.  The details of the algorithm are contained in an 

appendix to this user guide, but it is not necessary to understand the mathematics to use the 

software.   

Root Node 

Node 

Leaf Node 

Node 
 

Leaf Node 

Leaf Node 
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2 Installing TESLA 

2.1 System Requirements 
TESLA runs under 32 bit and 64 bit flavours of Windows XP, Vista and 7.  It may run under 

earlier versions of Windows (e.g. Windows 2000) which have been kept up-to-date, but the 

software has not been tested in such environments.  Any modern PC will meet the hardware 

requirements of the software. 

2.1.1 Microsoft .NET 

TESLA requires Microsoft .NET version 2.0 or later.  This is simply a library that provides many 

common pieces of software with the tools they need for drawing windows, manipulating files 

etc.; it is provided by default with copies of Windows Vista (.NET v3.0) and Windows 7 (.NET 

v3.5). 

If you are using Windows XP (or earlier) you may need to install or update Microsoft .NET before 

you can begin to use TESLA.  If you receive an error message during the installation process, or 

when trying to launch TESLA, that informs you that the correct version of the .NET framework is 

not available, you should use Windows Update to download the latest version of .NET.  Note 

that updates to the .NET framework are not usually listed as being ‘Critical’ or ‘High-Priority’, so 

will not appear if ‘Express’ is selected on the welcome page of Windows Update.  Choose 

‘Custom’ instead. 

2.2 Installation 
An installer for TESLA can be downloaded from the Quintessa Online website: 

https://www.quintessa-online.com/TESLA/ 

The software is packaged into a self-extracting installer, which should be saved to a suitable 

place on the destination computer.  Once downloading has completed, double-click on the .msi 

file to launch the installer which will lead you through the installation process. 

Once installed, TESLA can be launched via the shortcut on the desktop or the entry in the Start 

menu.  Until a licence is acquired TESLA will operate in restricted mode, as described below. 

2.3 Use of the Unlicensed (Restricted) Version 
An unlicensed copy of TESLA is known as the “Restricted” version, since a number of important 

functions are disabled - for example, decision trees cannot be saved and new trees cannot be 

constructed with more than 10 nodes. 

The Restricted version of TESLA may be freely used for the following: 

1. Evaluation of the software, prior to purchase. 

2. Viewing (but not altering the structure of) decision trees constructed in a licensed copy of 

the software. 

2.4 Purchasing a Licence for TESLA 
To unlock the full functionality of TESLA, a licence must be purchased from Quintessa.  Please 

email 
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tesla@quintessa.org 

for further details and a quote.  If you decide to purchase a licence, you will be sent instructions 

that will enable you to activate your licence online. 

2.4.1 Obtaining Your SID 

During the licence activation process, you will be asked for your unique System-Identifier code 

(SID).  To obtain this, launch TESLA on the computer you wish to purchase the licence for.  

Select ‘Order TESLA’ under the Help menu, to display a window similar to the one shown in 

Figure 2 below. 

 

Figure 2: The System-Identifier code needed to activate a TESLA licence. 

The code displayed in the window is unique for each computer.  It can be copied to the system 

clipboard (Ctrl-C) and pasted (Ctrl-V) to the required location. 

Once the activation process has been completed, a unique licence code will be emailed to you.  

Click ‘Enter Licence Code’ under the Help menu in TESLA, and paste the licence code into the 

box displayed (Figure 3). 

After a valid licence has been entered, complete functionality will be unlocked. 

The TESLA website (www.quintessa-online.com/TESLA) may also be used to carry out the 

following operations: 

▲ recover a lost licence code; 

▲ update personal details; 

▲ add a further machine to a licence (e.g. a laptop or home machine belonging to, and for 

exclusive use by, the licence holder). 

 

Figure 3: Entering the licence code to unlock TESLA. 

mailto:tesla@quintessa.org
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3 Building a Decision Tree 
The first step in decision-making using TESLA is to construct a hypothesis that represents your 

decision, as discussed in Section 1.4.  The next step is to construct a decision tree, by breaking 

down your main hypothesis into sub-hypotheses until the lines of reasoning reach a level of 

detail for which there is supporting or refuting evidence available.  This section describes how to 

go about this process using the TESLA interface. 

If at any stage during the tree-building process you are unsure as to what information must be 

entered in a given field, then a tooltip with guidance can often be produced by hovering over the 

associated field label with the mouse pointer. 

3.1 Creating a New Tree 
To create a new tree from scratch, click ‘New Tree’ under the ‘File’ menu (or use the button on 

the toolbar).  A Decision Details form will be shown (this can be retrieved at any point by 

selecting the menu option in the ‘Tree’ menu), as depicted in Figure 4.  Here the user can enter 

their name and a title and description for the tree.  This form is also used to report the tree 

version number, its current status and to access the change log, all of which will be discussed 

further later on. 

Once the user and tree details have been completed, press OK to close the form and start 

editing the tree itself. 

 

Figure 4: The Decision Details form 
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3.2 The Tree View Display 
The main view in TESLA is the Tree View display; this is where the decision tree is constructed 

and tree parameters and confidence values are added by the user.  When you first start a new 

decision tree the display will look like Figure 5, with a single node appearing.  This is the root 

node (see Figure 1) and will always be located at the top left of the tree.   

 

Figure 5: The Tree View display, showing a new decision. 

It is possible to have a number of trees open in the same instance of TESLA; each is displayed 

on its own tab, and navigation between them is achieved by clicking the tabs at the top of the 

Tree View display.  Each tab is labelled with a title which is supplied by the user when a new 

tree is created.  Hovering over a tab with the mouse cursor will display the file path of the 

associated .tes file in a tooltip (provided that the tree has already been saved to file).  A ‘#’ 

symbol in front of the tree name indicates that it contains unsaved changes. 

3.2.1 Zooming 

The magnification of the Tree View can be altered in a number of ways: 

 by using the slider and buttons at the bottom right of the TESLA window, or 

 by using the zoom items in the View menu or the associated keyboard shortcuts 

(Ctrl+Plus or Ctrl+Minus), or 

 if a mouse with a scroll wheel is available, then the zoom level can be changed by 

pressing Ctrl while scrolling the mouse.  

3.3 Editing a Node Name and Summary 
The root node should be the hypothesis related to your decision, as discussed in Section 1.4 of 

the Introduction.  For example, if our decision was whether to take an umbrella with us when we 

leave the house today, a corresponding root hypothesis might be “It will rain today”. 

To edit the title of a node, double-click it to bring up the Hypothesis Properties dialog (Figure 6).  

Enter the hypothesis in the ‘Short Hypothesis’ field, and a more detailed version (if required) in 

the ‘Detailed Hypothesis’ field.  The ‘Explanation’ box can be used to include a further 

explanation of terms used in the other two fields, or to include extra information about the 

hypothesis. 
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Figure 6: Editing short and detailed hypothesis titles in the Hypothesis Properties dialog. 

Closing the Hypothesis Properties dialog, you will see that the root hypothesis has been 

updated with the new name.  It is also possible to display the hypothesis summaries on the Tree 

View display; simply select Show Hypothesis Summaries from the View menu (this menu item 

can be toggled to turn summaries on and off). 

 

Figure 7: The Tree View display, with hypothesis summaries shown. 

3.4 Adding Child Hypotheses 
As described in the introduction, decisions are often complex and can be simplified by breaking 

them down into lines of reasoning, until leaf-level sub-hypotheses are defined with which there 

is associated evidence.  For example, our root hypothesis “It will rain today” could be broken 

down into the three sub-hypotheses “The weather forecast predicts rain”, “It is cloudy outside” 

and “It is already raining”.  Each of these is easier to establish the truth or falsehood of than the 

general statement “It will rain today”. 

To add a child hypothesis, right-click on the parent and select ‘New Child Hypothesis’ from the 

pop-up menu.  Repeat this process as many times as necessary. 
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Each of these sub-hypotheses might be broken down further.  For example, the hypothesis “The 

weather forecast predicts rain” could be broken down into the sub-hypotheses “The national TV 

forecast predicts rain” and “The local newspaper forecast predicts rain”.  Hypotheses should be 

continually simplified in this manner until a point is reached where the final sub-hypotheses (leaf 

hypotheses) are simple enough that it is easy to judge whether the available evidence supports 

or refutes them.  An example tree with a number of sub-hypotheses is shown in Figure 8. 

 

Figure 8: A simple example decision tree 

3.5 Node Numbering 
As shown in Figure 8, all nodes (except the root node) are automatically assigned numbers 

according to their position in the tree.  This makes it easy to identify nodes in a complex tree 

with many branches.  However, the numbers can be hidden by selecting ‘Hide Node Numbers’ 

from the ‘View’ menu.  The same menu item is also used to redisplay the node numbers once 

hidden. 

3.6 Expanding and Collapsing Nodes 
If a node has children (e.g. the root node, or node 1 in Figure 8) a small grey box is shown to the 

left of the node image.  Clicking on this box will show or hide that node’s children.   

It is also possible to collapse or expand all nodes at a given level, by right-clicking a node at the 

desired level and choosing ‘Collapse/Expand Tree at Selection Level’ from the pop-up menu.  

The ‘Expand All’ item in the main ‘View’ menu expands all collapsed nodes in the tree. 
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3.7 Editing Trees 

3.7.1 Cutting, Copying, Pasting and Deleting Nodes 

The ‘Edit’ menu contains the usual editing controls Cut, Copy, and Paste.  These are also 

available via keyboard shortcuts or right-clicking a node.  Nodes or groups of nodes can be cut 

or copied from a tree and pasted into the same or a different tree as a child node.  They can also 

be pasted into a new tree as a root node.  Note that if a node has children, they are also copied, 

as are the child node’s children, and their children, and so on until a leaf node is reached.  In 

other words, it is the whole tree branch that is copied rather than the single node.  It is worth 

noting that TESLA contains its own ‘clipboard’ to hold a copied section of a tree.  This internal 

clipboard will be lost when the application is closed. 

The root hypothesis can never be deleted, as it is an essential part of the tree, but any other 

node may be freely deleted.  Note that if a node has children, they will also be deleted – in fact 

the whole branch stemming from the selected node will be removed.  A second delete option is 

also found under the ‘Edit’ menu, which is ‘Delete Child Nodes’.  This deletes all of the currently 

selected node’s children (and branches stemming from them). 

3.7.2 Reordering Sibling Nodes 

Sibling hypotheses can be reordered by first by selecting a node and then shifting it up or down 

relative to its siblings.  This is achieved using the ‘Move Up’ and ‘Move Down’ options from the 

node’s right-click context menu or the associated keyboard shortcuts (Ctrl+Up and Ctrl+Down).  

Since the node numbering indicates the positions of the nodes in the tree, node numbers are 

automatically re-calculated. 

3.7.3 Altering the Decision Details 

The Decision Details form (Figure 4) appears whenever a new tree is started or an old tree 

opened from file.  It can also be viewed, and the information edited, at any point by selecting 

‘Decision Details’ from the ‘Tree’ menu. 
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4 Tree Parameterisation 
Before evidence is assessed and confidence values entered into the tree, it needs to be 

parameterised.  This includes specifying the relative importance of each sub-hypothesis, the 

degree of overlap between sub-hypotheses, and whether any sub-hypothesis could individually 

be a “show-stopper”.   

4.1 Sufficiency 
‘Sufficiency for’ and ‘sufficiency against’ parameters must, in general, be specified for each child 

hypothesis in the tree.  (Note that the use of logical operators, described in Sections 4.5 and 4.5, 

may make certain sufficiency values redundant.) They specify the degree to which proof or 

disproof of a hypothesis is sufficient to prove or disprove its parent hypothesis on a scale where 

0 means totally insufficient and 1 means totally sufficient.  In order to determine a sufficiency for 

or against parameter for a given hypothesis it can be helpful to ask the question: “If the 

hypothesis were known to be true or false, then how confident would you be that the parent 

hypothesis is true or false?”  

Sufficiency values influence how confidence values are propagated up the tree. Greater 

sufficiencies will result in confidence values being propagated more strongly up the tree 

hierarchy.  

To input sufficiency values for a node, double-click it to bring up the Hypothesis Properties 

dialog and select the ‘Parent Hypothesis’ tab.  Use the two sliders to input sufficiency for and 

against values (Figure 9). 

 

Figure 9: Editing sufficiency values. 

Sometimes the sufficiency for and sufficiency against values will be the same.  However, 

perhaps more often and as in our example, they may take different values.  Consider the 

hypothesis “It is already raining”.  Clearly, if this is true then the root hypothesis “It will rain 

today” must also be true.  This suggests that the sufficiency of confidence for should be 1.  

However, if this hypothesis is false (i.e. it is not currently raining) it doesn’t actually tell us much 

about whether it will rain later or not.  Thus the sufficiency of confidence against should be much 
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lower - here it has been set to 0.2.  This low sufficiency value means this hypothesis has a low 

weighting when considering confidence against. 

The sufficiency values of a node are depicted to the left of the node image, as shown in Figure 

10.  The sufficiency of confidence for is shown at the top, in green, and the sufficiency of 

confidence against is shown at the bottom, in red. 

 

Figure 10: The sufficiency values are shown to the left of the node image. 

4.2 Dependency 
With each set of sibling hypotheses there is a chance that some of the confidence they 

contribute to the parent hypothesis may arise from common judgements on evidence i.e. overlap 

in key elements of the evidence base, and the dependency value of the nodes reflects this.  The 

value must lie between 0 (no overlap) and 1 (full overlap).  This parameter is used to avoid 

‘double-counting’ of evidence when evaluating confidence in a parent. 

To edit the dependency between a set of sibling nodes, double-click their parent to bring up the 

Hypothesis Properties dialog and click the ‘Sub-Hypotheses’ tab.  Use the slider at the bottom 

right to change the dependency value. 

 

Figure 11: Editing the dependency between a set of sibling hypotheses. 

In our example, there is likely to be some dependency between the two sub-hypotheses “The 

national TV forecast predicts rain” and “The local newspaper forecast predicts rain”, since both 

will obtain their information from the same source (the Met Office).  Each may interpret this data 

differently though, with the local forecast being at a higher spatial resolution than the national 

one. 

The dependency value assigned to the children of a hypothesis is shown underneath the 

hypothesis image, as depicted in Figure 12. 
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Figure 12: The dependency between the children of a node is shown underneath the node 
image. 

4.2.1 Alternative Dependencies 

If there are more than two siblings, the level of overlap between each individual node and its 

siblings may differ.  In this case, a separate dependency value can be specified for each 

possible grouping of sibling nodes.  These are referred to as alternative dependencies.  To 

specify alternative dependencies, click the button ‘Specify Alternative Dependencies...’ on the 

Sub-Hypotheses tab (shown in Figure 11).  For the root hypothesis of our example the dialog in 

Figure 13 will be shown. 

 

Figure 13: Specifying alternative dependencies between groups of siblings. 

On the left is a depiction of all of the sibling nodes, each one of which is assigned a number in 

brackets.  On the right is a list of all possible groupings of the siblings.  A separate dependency 

value can be specified for each group by selecting it from the list and using the slider to enter a 

value. 

Note that the dependency of a group must be less than or equal to the dependency of any 

subgroup contained within it; for example, the dependency between all the siblings 1, 2 and 3 

cannot exceed the dependencies between 1 and 2, 1 and 3 or 2 and 3.  

If the children of a node have alternative dependencies specified, an asterisk will be shown next 

to the value of the dependence underneath the node image. 

4.3 Necessity 
The success of some nodes may be a necessity for the success of their parent – that is, nodes 

which, if they fail a ‘confidence test’, will necessarily lead to the node above failing the same test 

(for example, a site for a new supermarket must have planning permission – if the evidence 

suggests this will not be achieved, then there is no possibility that the site could be chosen, even 

if it was perfect in every other sense).    
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If a node marked as a necessity fails the predefined confidence test, then the confidence values 

for and against propagated to its parent will be at least as much as the confidence assigned to 

the failing hypothesis, irrespective of the sufficiency or dependency values specified (“at least as 

much” because siblings of the failed hypothesis may contribute extra confidence). 

To mark a node as being a necessity, double-click it to bring up the Hypothesis Properties dialog 

and select the ‘Parent Hypothesis’ tab (see Figure 9).  Check the box marked ‘Necessity’ at the 

bottom of the dialog.  Hypotheses that are a necessity are indicated on the Tree View display by 

a grey background to the node image, as shown in Figure 14. 

 

Figure 14: Necessity is indicated by a grey background. 

4.3.1 Node Failure 

There are two confidence test criteria that can be used to specify whether a node has failed: if 

the confidence against is greater than 0.5 (the default method); or if the confidence for is less 

than 0.5.  The criterion for determining node failure applies to the entire tree and can be set in 

the ‘Failure’ tab of the Options dialog, which can be found under the ‘Tree’ menu (Figure 15).  

This choice only affects nodes that have been marked as a necessity. 

 

Figure 15: Changing the definition of node failure. 

 

4.4 All Sub-Hypotheses Necessary 
In many situations, confidence in the parent hypothesis is dependent on achieving confidence in 

all of the child hypotheses. 

This represents a situation where all the child hypotheses are required collectively to ensure the 

success (or failure) of the parent, but where complete uncertainty about any one child alone 

would mean complete uncertainty about the parent.  This situation is represented by 

propagating the minimum confidence values from among the child nodes.  This form of logic is 

often (but by no means exclusively) used towards the top levels of a tree, to control integration 

of confidence arising from various different lines of reasoning. It reflects an assessment that 
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confidence in the parent can be no better than that for the ‘weakest link’ of the child nodes, and 

that there is no ‘mutual support’ i.e. confidence in child nodes does not combine in providing 

confidence in the parent. 

In some aspects, this can be thought of as an “AND” operation.  In our example, the fact that the 

sky is covered in cloud is not sufficient on its own to determine whether it is going to rain - we 

also need to ascertain whether the clouds are rainbearing or not.  Similarly if we spot a 

rainbearing cloud in the distance, but the rest of the sky is blue, it doesn’t necessarily mean that 

it will rain.  If we had no information about either one of these factors, we would be completely 

uncertain about whether it looks like rain.   

To override the propagation algorithm and specify that all sub-hypotheses are required for 

confidence in the parent, double-click the parent node to bring up the Hypothesis Properties 

dialog.  Click the ‘Sub-Hypotheses’ tab and chose the appropriate radio button (Figure 11) - the 

propagation method can be overridden for the confidence for and/or the confidence against.   

If the propagation algorithm has been overridden in this fashion, the sufficiency value in the 

node image is replaced by “ALL” in the Tree View display, as shown in Figure 16. 

 

Figure 16: If all sub-hypotheses are necessary, the sufficiency values of the siblings are 
replaced by “ALL” in the Tree View display. 

 

4.5 Any Sub-Hypothesis Sufficient 
In many situations, any and every single child hypothesis is sufficient on its own to ensure the 

success (or failure) of a given parent hypothesis, and each child is independent of the others. 

That is, if any one of the children is true, then the parent must also be, but confidence in the 

children does not combine to produce overall higher confidence in the parent than that for the 

node that represents the ‘strongest link’; the latter aspect is important to identifying if ANY 

should be employed rather than just employing a sufficiency value of 1 for all of the group of 

sibling nodes.  This is modelled by direct propagation of the maximum confidence value from 

among the child nodes.  As for the ‘ALL’ operator, this form of logic is often (but by no means 

exclusively) used towards the top levels of a tree, to control integration of confidence arising 

from various different lines of reasoning. 

In some aspects, this can be thought of as an “OR” operation - in our example, if we look outside 

through the window we know it is raining if either we spot some people sheltering under 

umbrellas OR we can actually see the raindrops splashing onto the ground.  Both of these 

hypotheses are sufficient on their own to have confidence in the statement that it is already 

raining.  However, the overall judgement of the truthfulness of the parent uses these different 

kinds of evidence independently; you would not be more likely to take an umbrella if you 
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observed raindrops splashing on the ground AND observed people sheltering under umbrellas, 

than if you saw ONLY raindrops splashing OR people sheltering (but no raindrops). 

To override the propagation algorithm and specify that any sub-hypothesis is sufficient for 

confidence in the parent, and that the confidence across the group does not combine when 

providing confidence to the parent, double-click the parent node to bring up the Hypothesis 

Properties dialog.  Click the ‘Sub-Hypotheses’ tab and choose the appropriate radio button 

(Figure 11) - the propagation method can be overridden for the confidence for and/or the 

confidence against.   

If the propagation algorithm has been overridden in this fashion, the sufficiency value in the 

node image is replaced by “ANY” in the Tree View display, as shown in Figure 17. 

 

Figure 17: If any sub-hypothesis is sufficient on its own, the sufficiency values of the siblings are 
replaced by “ANY” in the Tree View display. 

 

4.6 Recording Tree Parameterisation Choices 
TESLA aims to provide the capabilities necessary to record a complete audit trail for the 

decision.  This includes not only the sources of the evidence values that are entered, but also 

the rationale behind the tree structure.  The box labelled ‘Rationale’ on the ‘Notes’ tab of the 

Hypothesis Properties dialog is provided for this purpose (Figure 18). 

 

Figure 18: Entering a rationale for the tree parameterisation. 
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5 Entering Confidence Values 
Once the tree structure is complete, it is time to start collecting together sources of evidence and 

entering confidence values at the leaf nodes. 

5.1 About Confidence Values 
Confidence values can only be entered directly at a leaf node (a node with no children). 

Confidence values for all other nodes in the tree will be automatically calculated using the ESL 

propagation algorithm, described in Appendix A. 

Two confidence values must be entered for each hypothesis; confidence that the hypothesis is 

true given the available supporting evidence (“confidence for”) and confidence that the 

hypothesis is false given the available refuting evidence (“confidence against”).  These are 

quantified by selecting a number between 0 (no confidence; the evidence says nothing about 

the truth or falsehood of the hypothesis) and 1 (total confidence that the evidence supports or 

refutes the hypothesis). 

From these two confidence values an additional quantity can be calculated which will be 

referred to as the uncommitted belief which can vary from -1 to 1. 

(Confidence For) + (Uncommitted Belief) + (Confidence Against) = 1 

The uncommitted belief reflects the degree of uncertainty due to a lack of evidence or 

confidence in the evidence when positive and the degree of conflict due to overconfidence or 

inconsistent evidence when negative.  In order to help draw clearer conclusions evidence of 

sufficient quality and confidence should be gathered to reduce the uncommitted belief as close 

as possible towards zero. 

5.2 Assessing and Improving Confidence 
In an ideal world the evidence in support of or against each hypothesis would be such that it was 

conclusive, making it easier for decision makers to justify their decisions.  This is indicated in 

TESLA by strong confidence for or against the hypothesis being true.  See Figure 20, cases a) 

and b). 

However, the reality is often much less clear cut than that.  In the extreme case, there may 

simply be no evidence on which to make any judgement, so that the confidence for and against 

are both zero.  In this case the uncommitted belief is unity.  See Figure 20, case c). 

The amount of whitespace (positive uncommitted belief), is a measure of uncertainty related to a 

lack of evidence or a lack of confidence in the available evidence.  This could result from basic 

lack of information or from inaccuracies in experimental data etc.  Confidence can generally be 

improved by obtaining more evidence or improving the quality of evidence.  Reducing the white 

space on a leaf hypothesis will generally improve the levels of confidence up the tree towards 

the root hypothesis. 

After obtaining evidence and improving confidence it may still be the case that the evidence is 

inconclusive.  See Figure 19, case d).  When, as in this example, there is no white space at all 

(zero uncommitted belief), the flag can be thought of as indicating the odds that the hypothesis 

is true or false given the available evidence.  In some cases it may be possible to undertake new 

investigations or obtain new evidence that will shift the balance of confidence towards an 

assessment that the hypothesis is true or false.  Undertaking such actions to obtain further 

evidence can aid decision making. 
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Sometimes there may be a conflict in the confidence levels, identified by a negative 

uncommitted belief (over-committed belief) or a yellow overlap region in the flag.  See Figure 19, 

case e).  This may arise due to poor or inaccurate evidence or overconfidence in some or all of 

the evidence.  In this case action should be taken to identify and address the conflict
†
. 

a) 
 

Complete confidence that the hypothesis is true 

b) 
 

Complete confidence that the hypothesis is false 

c) 
 

No confidence, implying that there is no evidence on which to 

make any judgement for or against the hypothesis.  The 

uncommitted belief is unity. 

d) 
 

There is not a lack of evidence. (The uncommitted belief is zero.) 

However, the evidence that is available is not conclusive.  In this 

case, based on the available evidence it can be stated that there 

is a 50% chance that the hypothesis is true or false. 

e) 
 

The evidence is conflicting. (The uncommitted belief is negative.) 

Efforts could be undertaken to identify and eliminate the cause of 

the conflict.  The conflict could arise from over-confidence in the 

available evidence, or from poor quality or incorrect evidence, for 

example. 

Figure 19: Examples of flags indicating different confidence levels 

5.3 Inputting Confidence Values 
To input confidence for and against values, double-click a leaf hypothesis to bring up the 

Hypothesis Properties dialog then select the ‘Evidence’ tab.  Use the sliders to enter values 

between 0 and 1, as shown in Figure 20.  As you move the sliders the green and red bars in the 

graphic will increase or decrease in size accordingly; the green portion represents the 

confidence for and the red portion the confidence against.  The white section is the uncommitted 

belief.  Should the confidence values overlap (i.e. sum to more than 1), the overlap will be 

coloured yellow indicating conflict. 

In our example, for the hypothesis “The clouds are rainbearing” we have assigned a confidence 

for of 0.7, because about 70% of the clouds look like they contain rain; and we have assigned a 

confidence against of 0.1, because about 10% of the clouds look like they do not.  The 

remaining 0.2 is then the uncertainty arising from a lack of evidence or lack of confidence in the 

evidence, which could occur not only because we are not experts at identifying cloud types but 

also, for example, because some of the sky is obscured by buildings and trees around us. 

                                                        

†
 As discussed in Appendix A, ESL is founded on Probability Interval Theory and in this regard 

the uncommitted belief is equivalent to the uncertainty in the probability that the hypothesis is 

true or false. Therefore a negative value for the uncommitted belief is not consistent with a valid 

probability range. 
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Figure 20: Entering confidence values at a leaf node. 

In the Tree View display, the confidence values assigned to a hypothesis are displayed 

graphically in the node image, again using a horizontal green bar to show the proportion of 

confidence for, and a horizontal red bar to show the proportion of confidence against (Figure 

21).  The section between is coloured white to indicate the uncommitted belief, or coloured 

yellow when there is overlap in the case of conflict.  Due to its appearance, this image is 

sometimes referred to as an ‘Italian flag’. 
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Figure 21: The Tree View display with confidence values shown as “Italian flags” for each node. 

5.3.1 Linguistic Mappings 

Defining Mappings 

Sometimes, particularly when working with a group of experts in a workshop setting, it is 

preferable to use linguistic terms rather than numbers to indicate the confidence in the evidence 

that supports or refutes a hypothesis.  TESLA provides a mechanism for inputting confidence 

values linguistically. 

First of all, you should decide on a set of terms to represent the degrees of confidence in the 

evidence supporting or refuting a hypothesis.  The default set of terms in TESLA are “Very 

good”, “Good”, “Average”, “Poor”, “Very poor” and “None”.  You should then assign numerical 

confidence values to each of these, ranging from 0 to 1.  The default mappings used in TESLA 

are shown in Table 1.  The set of experts from whom you are eliciting confidence values should 

then be encouraged to use the linguistic terms, rather than numerical values, when describing 

their level of confidence in the evidence. 
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Table 1: The default linguistic mappings employed by TESLA. 

Linguistic Term Mapped Confidence Value 

Very good 0.9 

Good 0.7 

Average 0.5 

Poor 0.3 

Very poor 0.1 

None 0 

 

To set up linguistic mappings in TESLA, double-click a leaf node to bring up the Hypothesis 

Properties dialog.  Click the ‘Linguistic Mappings’ tab and select the ‘Linguistic Mappings’ radio 

button on the left (Figure 22). 

 

Figure 22: Specifying linguistic mappings to use for inputting confidence values. 

The default mappings are shown on the right.  These can be edited by selecting a term from the 

list then using the controls on the right to change the linguistic term and the mapping value.  

Press ‘Update’ when finished to commit any changes. 

If desired different linguistic mappings can be applied to confidence for or confidence against, 

using the check boxes above the slider control.  Also each leaf node can in principle be 

assigned its own set of linguistic mappings; however it is more likely that the same set will be 

used across all leaf nodes.  If that is the case, check the box ‘Use this method for all hypotheses 

in the tree’ on the left to apply the linguistic mappings entered here to all other leaf hypotheses.  

It is important to note that if the input mode is changed to linguistic after confidence values have 

been entered using the standard method with sliders (or a linguistic scheme is edited after 

confidence values have been entered), the existing confidence values will be altered by TESLA 

so that they are consistent with the new scheme.  So, for example, if a value of 0.95 had been 

entered and the default linguistic mapping scheme was then adopted, this value would be 

changed to 0.9 (corresponding to “Very Good”) since it is the nearest compliant value to the 

original.  Changing back to numerical confidence value input will not retrieve the original value of 

0.95 so care must be taken when using this option. 

Entering Confidence Values 

Once the linguistic mappings have been set, click the ‘Evidence’ tab to start inputting confidence 

values.  You will notice that the confidence sliders have been replaced by drop-down lists 

containing the linguistic terms defined on the ‘Linguistic Mappings’ tab (Figure 23).  To input 

confidence values simply select the relevant term from the drop-down boxes.   
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Figure 23: Inputting confidence using linguistic terms. 

5.3.2 Advanced Controls 

When assessing the level of confidence that can be had in the truth or falsehood of a hypothesis 

given the available evidence for or against, there are sometimes several factors that may 

influence the judgement, such as: 

 the quality of the evidence,  

 the quantity of evidence or evidence coverage; and 

 the face value of the evidence, i.e. of the evidence that is available, whether it supports 

or refutes the hypothesis. 

For example, a single piece of supporting experimental evidence may, if taken at face value, 

indicate that a hypothesis is true.  However, there may be doubts over technique or its accuracy, 

lowering confidence that the hypothesis is true.  On the other hand, several independent 

research groups may have independently verified the experiment – and this may act to increase 

confidence in the hypothesis being true.  In such situations it can sometimes be difficult to 

decide on an appropriate confidence value.  The advanced controls on the ‘Evidence’ tab of the 

Hypothesis Properties dialog can help to break down the assessment of confidence into 

component parts (quality, coverage and face value), thus making the judgments about the roles 

of the component parts more transparent.  

The advanced controls are disabled by default.  To enable them select the ‘Enable’ radio button, 

as shown in Figure 24.  To use the advanced controls the user will typically independently 

evaluate the quality¸ coverage and face value of the evidence in terms of provision of confidence 

in the parent. Sliders are available to input the relevant values for each. The final confidence 

values, indicated in the flag, are calculated as 

(confidence for/against) = (face value of evidence for/against) * (quality for/against) * (evidence 

coverage) 

Note that as uncertainty in evidence coverage and quality are covered by specific parameters, 

The face values can be thought of as providing a best estimate for the odds that the hypothesis 

is true or false given the available evidence, and the ‘face value of evidence against’ will 

generally be related to the evidence ‘for’ as follows: 
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1 - (face value of evidence for) 

This is because the primary sources of uncertainty are covered in the other sliders, and all that 

typically remains is to identify whether the evidence sources support the hypothesis or not.  

  

 

Figure 24: The advanced slider controls can be used to assess the impact of evidence quality 
and coverage on the judgement of confidence values. 

5.4 Recording Reasons for Selecting Confidence 

Values 
To provide a full audit trail of the decision, reasons for selecting particular confidence values 

should be recorded within TESLA.  To input this information, click the ‘Show Audit Trail’ button 

on the ‘Evidence’ tab of the Hypothesis Properties dialog.  The audit trail pane will appear on the 

left (Figure 25). 

 

Figure 25: Clicking “Show Audit Trail” on the “Evidence” tab will open the confidence details 
pane on the left of the dialog.  Here reasons for selecting confidence values can be entered. 
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There are two sections of the ‘Reasons’ tab in the evidence details pane; one for entering 

reasons for choosing the confidence for value, and one for entering reasons for choosing the 

confidence against value.  Both work in the same way.  To add a new reason, click ‘Add...’ 

underneath the relevant section.  In the dialog that appears enter a short title for the reason and, 

if required, a longer description, as shown in Figure 26.  You should also enter a name against 

the reason (this may be the name of the person editing the tree or, in a group workshop 

situation, the name of the expert who specifies the reason). 

When the reason is committed by pressing OK, its title will be shown in the relevant section of 

the audit trail pane. To view reason descriptions directly from the audit trail pane, simply hover 

the mouse over the reason title and the description will appear in a tooltip.  To edit an existing 

reason, select it and click ‘Edit’. 

Note that the reason title text box uses text completion to allow users to quickly input reasons 

(which may be applicable to multiple nodes in the tree).  Use the mouse, arrow keys or tab key 

to select the relevant reason from the list of possibilities - or keep typing to enter a new reason.  

If an existing reason is chosen, the description box will be filled in automatically. 

 

Figure 26: Adding a reason for selecting confidence values. 

5.4.1 Reference Files 

Often there will be files that back up confidence values, for example a spreadsheet which 

contains the output from a numerical simulation, a report describing experimental data etc.  

TESLA allows the decision maker to link such files directly to the tree. 

To add a reference file to a node, double-click the node to bring up the Hypothesis Properties 

dialog and select the ‘Reference Files’ tab.  A list of all reference files currently linked to the 

node will be displayed (Figure 27); click ‘Import’ to add another.  Select an existing report from 

the tree library or add a new one from the library on the local computer (see Section 8 for 

details). 
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Figure 27: Adding reference files to a node. 

Once a reference file has been linked to a node, it can be viewed by selecting it from the list of 

reference files and clicking ‘Open’.  This will launch the default application for the file type (e.g. 

MS Word for .doc files, Adobe Reader for .pdf files etc.) with the selected file opened for 

inspection. 

Nodes that have linked reference files are indicated in the Tree View display by a paperclip icon 

next to the node image, as shown in Figure 28. 

 

Figure 28: A paperclip icon indicates that a node has linked reference files. 

5.4.2 Links 

Supporting documentation for confidence values may often originate from a website.  The ‘Links’ 

tab on the Hypothesis Properties dialog (Figure 29) allows the user to link website URLs to a 

node; simply enter the website address in the ‘Link’ box and press ‘Add’.  Once a website has 

been added in this manner, it can be double-clicked to launch the default web browser and load 

the website. 

The Links tab could also be used to link to a file, if that file is not required to be embedded in the 

tree itself - for example, some organisations have central filesystems where documents relevant 

to all employees are stored.  A link to a file can be added by prepending the file name by file:///, 

e.g. 

file:///C:\Users\Default\Documents\myDocument.pdf 

This should only be used in preference to the ‘Reference Files’ tab for adding links to files if the 

file that is being linked to is available to everyone that might want to work on or view the 

decision tree, using the same path. 
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Figure 29: The Links tab, which allows the user to link website URLs to a node. 

5.5 Recording Outstanding Actions 
Once confidence values have been entered against hypothesis, it can also be useful for decision 

makers consider classes of actions that could be taken to strengthen what can be said about the 

truth or falsehood of the hypothesis.  Here are two examples of ways in which a hypothesis can 

be strengthened to make it more conclusive: 

 Reduce Uncommitted Belief: Improvements can be made by reducing the uncommitted 

belief towards zero.  This can be achieved by obtaining further evidence so to address 

uncertainty due to lack of evidence or by addressing conflict of evidence.  For example, 

to improve confidence in our judgement for the “The clouds are rainbearing” we could 

get a book from the library about cloud forms, or gather a group of independent 

meteorological experts to provide their judgements too. 

 Improve the Balance of Confidence: Conclusiveness can be improved by obtaining 

further evidence or undertaking new studies that are designed to shift the balance of 

confidence towards full support for the hypothesis being true or false.  For example, if 

the hypothesis related to the performance characteristics of an underground gas 

storage system, then we may be able to improve conclusiveness of the hypothesis by 

adopting different engineering practices that are known to provide a better final injection 

well seal.  

Note that some evidence gathering actions will affect or improve both to some degree. TESLA 

provides a mechanism whereby users inputting confidence values can list actions that could be 

undertaken to strengthen the conclusiveness of the hypothesis. 

To enter such actions double-click the relevant leaf node and select the ‘Evidence’ tab from the 

Hypothesis Properties dialog. Click ‘Show Audit Trail’ to show the audit trail pane on the left (if 

not already visible). Within the pane itself, click the ‘Actions’ tab. This tab is split into two 

sections; one for entering actions to improve confidence and one for entering actions to improve 

conclusiveness (see Figure 30). These sections behave similarly to the sections on the 

‘Reasons’ tab (see Section 5.4 for details) and actions are entered in the same manner. 
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Figure 30: Clicking ‘Show Audit Trail’ on the ‘Evidence’ tab will open the audit trail pane on the 
left of the dialog.  Here actions for improving confidence and conclusiveness can be entered. 
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6 Analysing the Decision 
Once a tree has been parameterised and populated with confidence values it can be used to 

inform decisions and to identify areas where efforts could be focussed in order to improve the 

conclusiveness of the root hypothesis.  TESLA includes a number of graphical tools that can be 

used for such purposes: 

 Uniform Confidence (Section 6.1) plots can be used to check that the parameterisation 

of the tree is plausible and that it does not preclude a positive or negative outcome. 

 Decision makers often are concerned by the question “How confident can we be that the 

root hypothesis is true or false given the available evidence?” If the confidence values 

propagated to the root node, as shown in the Tree Plot, are sufficiently conclusive then 

it may be that no further action needs to be taken. (See Section 6.2.) However, the user 

may want to analyse the sensitivity of the outcome to changes in confidence in the leaf 

nodes. (Section 6.4) 

 If the root hypothesis is not conclusive then the decision maker will typically wish to 

identify why not.  There may be areas were evidence is lacking or where it is in conflict 

leading to ambiguity.  The Ratio Plot (Section 6.3) helps decision makers to identify 

hypotheses on which to focus effort in order to improve the conclusiveness of the root 

hypothesis. 

 Tornado Plots (Section 6.4) help answer the question “Which hypotheses have the 

greatest impact on confidence in the root hypothesis?” This can also help the decision 

maker to decide which hypotheses to focus effort on in order to most effectively improve 

the conclusiveness of the root hypothesis. 

6.1 Uniform Confidence Plots 
It is important to test the tree structure during the decision making process to ensure that the 

values chosen for sufficiency, dependency etc.  lead to expected results.  For this purpose, a 

tool to produce Uniform Confidence plots is provided.  This tool allows the user to temporarily 

assign the same confidence value to all leaf nodes in the tree, thus determining if confidence is 

propagated through the tree as intended.  The most useful confidence values to apply to the leaf 

nodes are confidences for and against of 1, though any values can be chosen. 

To produce a Uniform Confidence plot, select the menu item from the ‘Plots’ menu in the main 

TESLA window.  A dialog will appear (Figure 31), into which the confidence value to be 

assigned to leaf nodes can be selected using the two sliders. 
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Figure 31: The Uniform Confidence plot dialog.  On the left, the root node for the plot should be 
selected.  On the right, the level at which to apply the uniform confidence should be selected.  

The confidence to apply is specified using the sliders at the bottom of the dialog. 

At the top are two panels, each showing a summary of the decision tree.  In the left panel the 

root node for the plot should be selected - this does not have to be the root node of the whole 

decision tree.  On the right, the level at which the uniform confidence should be applied should 

be selected - again, this does not have to correspond to leaf nodes in the decision tree, uniform 

confidence can be applied at any level.  All nodes at which the confidence will be applied are 

highlighted in light blue.  These are nodes at the same level as the selection, or any leaf nodes 

higher than the selection (but in the same branch, i.e. underneath the selected root node).  

Press ‘OK’ to display the plot. 

The Uniform Confidence plot is similar to the Tree View display, but only the nodes between the 

selected root node and the selected leaf nodes are displayed.  An example plot is shown in 

Figure 32; here the uniform confidence was applied at the first level in the tree.  This plot shows 

that our choices of tree parameters will allow a conclusive answer to be calculated for the root 

hypothesis “It will rain today”; this may not always be the case, depending on the values chosen 

for sufficiency etc.  Usually the parameterisation of trees that do not produce a conclusive result 

should be reconsidered. 
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Figure 32: A Uniform Confidence plot for the first level in the tree. 

By selecting alternative root nodes it is possible to concentrate on branches of a tree rather than 

the whole decision; for example, a Uniform Confidence plot for the “Weather forecast” branch of 

our tree is shown in Figure 33.  Here the parameterisation of the tree (specifically the 

dependency coupled with the sufficiency values) means that the confidence in support of the 

hypothesis “The weather forecast predicts rain” could never actually reach a value of 1.  This 

may indicate that the tree parameters need to be altered. 

 

Figure 33: A Uniform Confidence plot for the “Weather forecast” branch. 

6.2 Tree Plot 
The Tree Plot is the standard TESLA view of the hierarchy of hypotheses.  Using flags, it shows 

how confidence in the leaf hypotheses propagates to the root hypothesis, as well as indicating 

how the tree has been parameterised.  By looking at the root hypothesis the decision maker can 

judge whether, given the confidence values assigned to the leaf hypotheses and the tree 

parameterisation, the root hypothesis is sufficiently conclusive.  See Section 5.2. 

6.3 Ratio Plots 
A Ratio Plot is used to analyse a decision once confidence values have been input.  It 

summarises graphically the confidence values for all selected hypotheses. It is structured to 

enable identification of hypotheses for which the balance of confidence is weak (neither strongly 

supporting or refuting the hypothesis), and those for which there is a lack of, or conflict in 
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confidence (large uncommitted or over-committed belief).  To produce a Ratio plot, simply select 

the menu item from the ‘Plots’ menu in the main TESLA window. 

The horizontal axis of the Ratio plot indicates the percentage uncommitted belief, with an 

increasing negative value representing increasing conflict. 

The vertical axis indicates the ratio of confidence for to confidence against.  To avoid division by 

zero in this calculation, all confidence values are moved into the range [0.01, 1] (confidence 

values lying below this range are set to the bottom boundary value).  This results in a possible 

ratio between 0.01 and 100.  The calculated values are then plotted using a logarithmic scale. 

The background of the plot is shaded to indicate areas where confidence values are greater 

than or less than 0.5.  Along with the two axes, this splits the plot up into eight distinct regions, 

summarised in Figure 34.  The user may also define their own ratio plot regions, as described 

below in Section 6.3.1.  Points that lie in the dark green or dark red areas indicate more 

conclusive levels of confidence, i.e. the confidence for (or against, in the red region) is greater 

than 0.5 and the confidence against (or for, in the red region) is less than 0.5.  The nearer to the 

top or bottom of the vertical axis the point lies, the confidence there is that the hypothesis is true 

or false. 

 

Figure 34: Regions of the Ratio plot 

A Ratio plot for the example we have been following is shown in Figure 35.  Most of the 

hypotheses, including the root hypothesis (labelled 1 in the Ratio plot) lie in either the dark green 

or dark red areas, indicating that there is strong confidence that they are either true or false.  

The point labelled 6 on the plot (corresponding to “People outside have umbrellas up” lies in the 

lighter red region, indicating that there is a lack of confidence about the truth or falsehood of this 

hypothesis.  This may lead us to do some more research in that area (spending longer looking 

out of the window for example, to see more people go by). 
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Figure 35: Ratio plot for the umbrella example.  Each numbered circle represents a hypothesis, 
as indicated in the legend.  The root hypothesis (1) lies within the dark green area indicating that 

there is strong confidence that the hypothesis is true. 

6.3.1 User-Defined Ratio Plot Regions 

As depicted in Figure 34 and described above, the coloured regions of the Ratio plot indicate 

areas where there is stronger and weaker confidence that hypotheses are true and false.  By 

default, the ratio plot is split into 4 distinct regions based on the values of confidence for and 

against.  The user can specify their own regions on the Ratio plot by selecting ‘Options...’ from 

the ‘Tree’ menu in the main TESLA window, and clicking the ‘Ratio Plots’ tab (Figure 36). 

Select the ‘User Defined’ radio button to activate the user-defined regions.  TESLA provides 

some suggestions but these can be altered as desired; a maximum of 5 regions can be 

specified.  Enter the region names and confidence ranges as required, and press ‘OK’ to commit 

the changes. 

The Ratio plot for our example with user-defined regions is shown in Figure 37.  With this 

greater refinement of regions on the plot, the root hypothesis lies in the “Significant Doubt” band 

indicating that whilst the balance of confidence is in favour of the hypothesis being true, there is 

a sufficient lack of confidence and sufficient confidence that the hypothesis is false to cast doubt 

on the outcome. 
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Figure 36: User-defined regions for the Ratio plot can be specified in the Options dialog (located 
under the Tree menu). 

 

 

Figure 37: A Ratio plot with user-defined regions. 
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6.4 Tornado Plots 
Like Ratio plots, Tornado plots are designed to analyse trees that have been populated with 

confidence values.  The aim of the Tornado plot is to calculate the impact that the confidence 

values of each leaf hypothesis have upon the overall decision; that is, how sensitive the root 

hypothesis confidence values are to small changes in the confidence values of the leaf 

hypotheses.  This can aid the decision maker by identifying areas where extra research to 

improve confidence is valuable, and areas where it would have little or no effect. 

This is essentially a differential calculation, and is implemented in TESLA by temporarily 

incrementing by a marginal amount the confidence values of each leaf hypothesis in turn, noting 

the change in confidence values of the root hypothesis.  The sensitivity of the confidence values 

at the root node will depend upon the confidence values that have been assigned to the leaf 

nodes and on the manner in which the tree has been parameterised. 

The impact, calculated separately for confidence for and confidence against, is defined to as: 

                                                 

                                                 
 

The calculated impact for each type of confidence is converted to a percentage, and plotted as a 

horizontal bar on the Tornado plot.  This bar is coloured green to indicate sensitivity to 

confidence for and coloured red to indicate sensitivity to confidence against. 

The nodes are plotted in descending order of total impact, thereby giving the whole plot its 

tornado-like appearance from which it takes its name.  The hypotheses are listed in a legend 

underneath the plot, in ranked order.  

To generate a Tornado plot, simply choose the menu item from the Plots menu in the main 

TESLA window.  A plot generated for our example tree is shown in Figure 38.  

Here we see that the top-ranked hypothesis is “The local newspaper forecast predicts rain”.  

This means that if a small change is made to the confidence for value of this node, there would 

be a (relatively) large change to the confidence for value of the root node.  Thus it might be a 

good idea to try to reduce the amount of uncertainty here by conducting some more research.  



 

 39 

 

Figure 38: A Tornado plot generated for the umbrella example. 

   

Note that empty tornado plots may be produced if some nodes are necessary and always result 

in the failure of the root node.  This is because TESLA is correctly showing that small 

perturbations to the leaf nodes have no effect in this case as the confidence from the necessary 

nodes is propagated favourably instead.  If the necessary node does not, by itself, cause the 

failure of its parent then the tornado plot will not be empty. 

A similar effect is also seen if the propagation method has been overridden by specifying that all 

sub-hypotheses are necessary for a particular parent hypothesis.  This is the case for our 

example tree where the sibling hypotheses “The clouds are rainbearing” and “At least 80% of 

the sky is covered in cloud” are both marked with “ALL”.  As seen in Figure 38, the impact of 

“The clouds are rainbearing” on the root hypothesis is shown to be zero, since it is always the 

minimum confidence value from the pair that is propagated (and thus changing the value of one 

may not affect the value of the parent). 

An important point to note is that as Tornado plots consider the sensitivity of the tree to small 

variations in leaf level confidence values, they do not always capture the overall sensitivity of the 

tree to larger changes in such values, which might ‘trip’ certain logical criteria and lead to 

markedly different overall outcomes. Changes in success/failure of ‘necessary’ nodes, and of 

the ‘weakest’ or ‘strongest links’ from groups of nodes whose confidence propagation is 

controlled by ALL or ANY logical constructs are examples of this. Thus, the Tornado plot, 

although a very powerful analysis tool, needs to be carefully used with these factors in mind. 
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7 Outputs 
TESLA provides a variety of methods for outputting information about a decision, all of which are 

summarised in this section. 

7.1 Tree Plots 
One of the most important outputs from TESLA is the decision tree itself.  Whilst screenshots of 

the Tree View display can be taken for inclusion in reports etc., the Tree plot produces a copy of 

the Tree View and can be used to display both the whole tree and branches of a tree.   

To draw a Tree plot, select the menu item from the ‘Plots’ menu in the main TESLA window.  If a 

plot of a branch is required, rather than the entire tree, select the desired root node in the Tree 

View display first.  Once a Tree plot has been drawn, it can be printed or saved as an image for 

inclusion into a report via the options on the File menu. Figure 39 shows a Tree plot of a branch 

of the example tree. 

 

Figure 39: A Tree plot of a portion of the example decision. 

7.2 Decision Summary Reports 
TESLA can automatically produce summaries containing information about all aspects of the 

decision.  These summaries can be produced as Word or PDF documents, and can either be in 

Report format (portrait, comprehensive information, can be used as a standalone document or 

as part of a larger report) or Presentation format (landscape, larger fonts and contain just the 

most important points about the decision). 

To produce a summary report, choose ‘Create Report...’ from the ‘Reports’ menu in the main 

TESLA window.  A dialog similar to the one shown in Figure 40 will be displayed.  From here the 

report type and format can be selected.  As well as Word and PDF formats, reports can be 

displayed on-screen in the Report Viewer tool - reports viewed in this fashion can also be 

exported directly from the Report Viewer tool to Word or PDF format. 

Some elements of the report are optional, for example tables of reasons for selecting confidence 

values, lists of linked reference files and the various plots.  Use the check boxes to select which 

elements to include in the report (note that some elements are not available in Presentation 

reports). 
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Figure 40: The Report Choices dialog (select ‘Create Report’ from the ‘Reports’ menu).  From 
here the report type, format, elements and level of detail can be specified. 

In addition, the level of detail to include in the report can be chosen from the Report Choices 

dialog using the radio buttons at the bottom.  The choices are as follows: 

1. Whole Tree.  Information about the entire tree is included in the report, from root to leaf 

nodes. 

2. Root Hypothesis + Children.  Only information about the root hypothesis and its 

immediate children are included.   

3. Truncated Tree at...  Use the drop-down box to select the level at which to truncate the 

tree.  Level 0 represents the root node; Level 1 is the children of the root; Level 2 is their 

children etc.  Thus selecting Level 1 here would be equivalent to selecting “Root 

Hypothesis + Children”. 

4. From Hypothesis...  This option allows you to report on a single branch of the tree.  Use 

the first drop-down to select the root node for the tree, and the second to select the level 

at which to truncate the tree.  As described above, Level 0 is the root node; Level 1 is 

the children of the root; Level 2 is their children, etc. 

Once the report options have been chosen, click OK to generate the report.  If Word or PDF 

formats have been chosen you will be asked to provide a filename for the report.  The report will 

then be created, and displayed in the default application for that format (e.g.  Word or Adobe 

Reader).  A section of a summary report (in Report format) is shown in Figure 41.  
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Figure 41: Excerpt from a summary report generated by TESLA (Report format) 

7.3 Leaf Reason and Action Summary File 
In addition to the summary reports described in Section 7.2 above, a CSV (comma separated 

value) file can be produced by TESLA summarising all the reasons entered against leaf nodes 

for selecting confidence values, and all outstanding actions to reduce the uncommitted belief 

and to improve the balance of confidence. 

To produce a leaf summary file, select ‘Create Leaf Summary CSV File...’ from the ‘Reports’ 

menu in the main TESLA window.  An excerpt of a file is shown in Figure 42.  As this is a CSV 

file there is no formatting, but formatting can be applied manually later using Microsoft Excel (or 

another spreadsheet tool that reads .csv files). 

 

Figure 42: Excerpt of a leaf summary CSV file, which contains the reasons and actions entered 
against each leaf node in the tree. 

If a hypothesis has multiple reasons or actions entered against it, it will have multiple lines in the 

file (e.g. hypothesis 2.2 “The clouds are rainbearing” in the example shown in Figure 42, which 

has two actions to reduce uncommitted beliefs entered against it). 
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8 Managing the File Library 
As described in Section 5.4.1, TESLA allows the user to link reference files to particular nodes.  

The Library is used to manage these files, and is described in detail in this section. 

8.1 The Tree Library 
The Tree Library contains all of the reference files that have been linked to the current tree (this 

includes files that may have been linked to previous versions of the tree but may no longer be 

required).  Whenever a new file is attached to a node, it will be added to the Tree Library. 

To view or edit the Tree Library, select ‘Manage Reference Files...’ from the Tree menu in the 

main TESLA window.  The Reference Document Manager dialog will appear, as shown in 

Figure 43.  All of the files currently used in the tree are listed here.  The ‘Description’ field can be 

edited to provide information about what the file contains.  The ‘Status’ field indicates whether 

the file is embedded in the tree file (“Embedded”), not embedded but available locally (“In 

Library”), or could not be found (“Missing from Library”). 

 

Figure 43: The Reference Document Manager dialog.  This lists all the documents that have 
been referenced in the current tree. 

Reference files can either be linked or embedded.  An embedded file is literally embedded in the 

tree, and is saved (in binary format) within the decision file itself.  Although this can lead to bulky 

files, it allows the user to easily share their trees and reference files with others without having to 

worry about manually collecting together all the reference files. 

A linked file is simply stored locally on the user’s computer as a separate file and is accessed 

when required.  When the tree is saved, options will be provided to either embed linked files or 

leave them as separate entities (see Section 8.3 for details). 

To embed a single file, right-click on it in the Reference Document Manager dialog and select 

‘Embed...’ from the pop-up menu.  To embed all files in the library, click the ‘Embed All’ button.  

Similarly embedded files can be detached by right-clicking and selecting ‘Detach...’ or clicking 

the ‘Detach All’ button.  To view a file, right-click on it and select ‘Launch...’.  It will be launched 

in read-only mode using the default application. 

 

8.2 The Local Library 
The Local Library is a repository on your computer for all the files that have been linked to 

TESLA decision trees.  It enables you to quickly and easily locate reference files that are used 

regularly in your decisions, and as it is a central repository containing copies of the files it guards 

against accidental deletion or the moving of important files. 
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Any reference file added to the Tree Library must also be added to the Local Library.  To 

manage the Local Library, select ’Manage Local Library’ from the ‘File’ menu in the main TESLA 

window to bring up the Library Manager (Figure 44). 

 

Figure 44: The Local Library Manager dialog.  This displays the contents of your TESLA file 
repository, covering all decision trees that have been created. 

The Library Manager shows the file details, including a description which can be edited by 

clicking twice in the cell.  The “Status” column indicates whether the file is “Available” or 

“Missing” - missing files may have been deleted accidentally from the central repository outside 

TESLA.  It is not recommended that the library should be edited in any manner other than via 

the Library Manager within TESLA.  The “TESLA Files” column lists the filenames of decision 

trees on the local computer to which the file is known to have been linked. 

To add a new file to your library, click the “Import” button and browse for the file.  To delete a 

file, select it from the list and click “Delete”.   

8.3 Saving Trees with Linked Files 
There are 3 options available when saving a decision tree file containing linked reference files: 

1. Embed.  The files can be embedded as binary objects in the tree file itself.  This means 

that the files and the tree are intrinsically linked and eliminates problems of missing 

reference files.  It allows users to share trees easily.  However it can lead to bulky 

decision tree files.  Choose this option if you want to share your tree and only have a few 

linked reference files. 

2. Archive.  The files can be collected together into a TESLA document archive (.tda file), 

which can be distributed independently from the tree but ensures that the reference 

documents are held together in a single location and clearly marked as being part of a 

TESLA tree.  The TESLA document archive file is saved in the same folder as the TESLA 

tree file (.tes).  When loading a TESLA tree file, if a corresponding document archive is 

present in the same folder, TESLA will read the documents from the archive file and add 

them to the local library if necessary.  Choose this option if you want to share your tree 

and have a large number of linked reference files. 

3. Omit.  The files can be omitted from the tree file but retained locally.  This means that 

other users you share your tree with will not be able to view the linked files, but the 

decision tree file will be small.  Choose this option if you do not need to share your tree or 

if the linked files are not important when sharing. 
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Figure 45: This dialog appears when a decision tree containing linked files is saved.  It allows 
the user to embed, archive or omit the linked files. 
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9 Working with Sub-Trees 
Decision trees created with TESLA can often be complex, with many nodes and levels.  Often it 

helps to work on individual parts of the tree and focus on the issues involved there rather than in 

the context of the whole decision.  TESLA allows the user to identify a branch of the tree to work 

on, break it off from the main tree, alter parameters and values without affecting the main tree, 

and then subsume the changes back into the main tree (or cancel). 

 

Figure 46: Working on a Sub-Tree 

To start working on a sub-tree, in the Tree View display select the node that will be the root of 

the branch to be worked on.  Right-click and select ‘Work on Sub-Tree’ from the pop-up menu.  

A new tab will be opened containing the selected branch as a separate tree.  See Figure 46 for 

an example, which shows a Sub-Tree for the hypothesis “The weather forecast predicts rain” of 

the Umbrella decision. Make all the changes necessary here - the main tree will be unaffected - 

and when ready, click the ‘Apply’ button at the bottom of the window to subsume the changes 

back into the main tree.  Click ’Cancel’ to return to the main tree without accepting the changes. 

Sub-Trees are useful both when parameterising the tree (to study the behaviour of the branch in 

detail) and when entering confidence values (particularly in a group workshop; by breaking off a 

Sub-Tree, it helps to focus the group on the particular branch in question). 
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10 Version Control 
TESLA includes built-in version control that records the history of changes made to a decision 

tree. 

10.1 Tree Versions 
A new tree version is created whenever a tree is closed and re-opened (saving does not create 

a new version), or when a tree is reviewed or approved (see Sections 10.3 and 10.4).  Versions 

are stored in the Change Log and can be viewed at any time.  The current version number of a 

tree is shown on the Decision Details dialog and in brackets after the tree title on the tab label of 

the Tree View display. 

10.2 Change Log 
All versions and a list of the changes they include are recorded in the Change Log, which can be 

accessed either from the Decision Details dialog or the ‘Tree’ menu.  The Change Log dialog is 

shown in Figure 47. 

 

Figure 47: The Change Log dialog. 

The Change Log shows each version number, the date it was modified and the user who 

modified it (as entered in the Decision Details dialog when a tree is opened).  By clicking the 

plus sign next to an individual version, it can be expanded to show full details of the changes 

included in that version. 

10.2.1 Viewing an Old Version 

Every version of a tree is stored and can be viewed at any point by selecting it from the Change 

Log and clicking ‘View’.  The old version will be opened in a new tab in the main TESLA window, 

and all the information in it can be viewed but not edited. 

10.2.2 Rolling Back 

It is possible to “roll back” to an old version of a tree, losing all changes that were made to the 

tree after that version.  To roll back, simply select the tree version in the Change Log and click 

’Roll back’.  The tree will be replaced in the main TESLA window by the selected version.   

It is not possible to roll back past a reviewed or approved version of a tree (see below). 
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10.2.3 Exporting an Old Version 

Rather than rolling back to an old version, you may wish to edit an old tree without losing the 

changes made to the current version.  In this case, the old tree should be exported, i.e. saved as 

a separate tree file, which can then be edited whilst retaining the original tree. 

To export an old version, select the version in the Change Log and click ‘Export...’.  This will 

open the old version of the tree in a new tab, from where it can then be edited and saved under 

a different filename. 

10.2.4 Labelling Versions 

In order to allow the user to quickly identify versions in the Change Log, it is possible to label 

specific versions.  To label a version, select it in the Change Log window and click ‘Label...’.  

Enter a label for the version in the box that appears (Figure 48), or select an existing one from 

the drop-down list, and press ‘OK’ to apply the label. 

 

Figure 48: Labelling a version in the Change Log. 

Version labels are shown in brackets in the Change Log after the version number, as shown in 

Figure 49.  Versions that have no label applied are marked as “Unlabelled”.  The check box 

‘Only Show Labelled Versions’ can be used to restrict the view in the Change Log window to just 

those versions which have a label applied. 

 

Figure 49: A Change Log dialog showing labelled versions. 

10.3 Reviewing a Tree 
Once a tree has been completed it might be peer reviewed.  TESLA allows trees to be marked 

as “Reviewed”, recording the date of the review and the name of the reviewer.  To mark a tree 

as having been reviewed, select ‘Actions’ and then ‘Review’ from the ‘Tree Specific Actions’ in 

the ‘Tree’ menu.  Enter the name of the reviewer in the dialog that appears and press ‘OK’.  You 

will then be asked to provide a label for the reviewed version; the default is “Reviewed” but you 

may choose any label you wish. 

Reviewing a tree will cause the tree version number to be incremented.  The reviewed version 

will be visible in the Change Log both by its label and “REVIEWED” following the name of the 

last editor of the tree (Figure 50). 
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Figure 50: A Change Log dialog, showing a reviewed version. 

Once a tree has been reviewed, it is not possible to roll back to versions prior to the reviewed 

version.  However it is possible to edit the current tree.  Trees that have been reviewed and 

subsequently edited are indicated as such on their Decision Details dialogs. 

A tree may be reviewed any number of times, and each review version is clearly marked in the 

Change Log. 

10.4 Approving a Tree 
A tree can only be approved once it has been reviewed.  To mark a tree as having been 

approved, select ‘Actions’ and then ‘Approve’ from the ‘Tree Specific Options’ in the Tree menu.  

Enter the name of the approver in the dialog that appears and press ‘OK’.  You will then be 

asked to provide a label for the approved version; the default is “Approved” but you may choose 

any label you wish. 

Approving a tree will cause the tree version number to be incremented.  The approved version 

will be visible in the Change Log by its label, “APPROVED” following the name of the last editor 

of the tree, and the entry being in a bold typeface (see Figure 51).  The check box ‘Only Show 

Approved Versions’ can be used to restrict the Change Log view to only approved versions. 

 

Figure 51: A Change Log dialog, showing an approved version in bold. 

Once a tree has been approved, it is not possible to roll back to versions prior to the approved 

version.  However it is possible to continue editing the current tree (the approved version will be 

retained in the Change Log and can be viewed at any time).  Edited trees are marked as 

unreviewed and unapproved in the Decision Details dialog. 

A tree may be approved any number of times, though it may only be re-approved after it has 

been re-reviewed.  The review/approval cycle is summarised in Figure 52. 
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Figure 52: The review and approval cycle. 
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11 Designing and Exporting Templates 
In some situations it can be useful to use the same hierarchy of hypotheses to assess multiple 

options or even projects. For example, when choosing a site for a new supermarket, the same 

factors may be assessed for each candidate site to enable them to be readily compared.  

TESLA allows users to design and export template trees which can then be used across multiple 

options or projects, ensuring that the same tree structure is used in each case.  In addition, 

TESLA allows the creators of the template trees to embed guidance that can be accessed by the 

people populating those trees. This section describes how to create a template tree and how to 

generate new trees based on an existing template. 

Once multiple trees based on the same template have been populated then, provided the 

structure of these trees has not been changed, they can be compared in TESLA using the 

portfolio tool.  This is described in Section 12. 

11.1 Designing a Template 
A template tree starts off life as a normal tree.  It is only at the final stage of creation when it 

becomes a template.  To create a template, start a new tree or open an existing tree as normal.  

You should ensure that the tree structure is logically arranged and well explained, and that any 

linguistic mappings (Section 5.3.1) or user-defined ratio plot regions (Section 6.3.1) have been 

set up. 

11.1.1 Entering Template Guidance 

Guidance can be provided by the template designer that will subsequently be made available to 

users of trees derived from the template when they input confidence values.  This guidance can 

include guideline confidence values (for example, to delimit expected attainable values), 

sources of evidence, discussions of how to map evidence to numerical values etc. 

Template guidance can be added to any tree that has not been based on an existing template. 

To add template guidance to a hypothesis, double-click the node to bring up the Hypothesis 

Properties dialog and select the “Template Guidance” tab (note that this tab only appears for 

leaf hypotheses). 

 

Figure 53: The Work Elements tab. 
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Use the sliders to input guideline confidence values that you wish users of your template to see.  

An explanation, or any other notes, can be entered into the “Explanation” box.  Again, this will 

also be visible by users of your template.  It is also possible to link supporting documentation to 

the Template Guidance tab, using the controls on the right - this feature works in a similar 

manner to the reference files described in Section 5.4.1.  Within the ‘Add Document’ dialog, it is 

also possible to specify a relevant page within the document.  If the document is a PDF, then 

when the template user views the file it will automatically open at the right page.  If the 

document is not a PDF the page number simply acts as a guide to the user who will have to 

navigate to the correct page manually. 

11.1.2 Pre-Defined Version Labels 

As a template designer, you may wish to specify a set of version labels that users of your 

template can apply to their trees at various stages of the tree development process.  To do so, 

open the Change Log (via the Tree menu or Decision Details dialog) and click the ‘Pre-defined 

Labels...’ button.  The dialog that appears (Figure 54) lists all of the labels currently used in the 

tree; new ones can be added by typing the label text in the box at the bottom and clicking “Add”.  

Labels created via the Change Log, using the method described in Section 10.2.4, will 

automatically be added to the list.  

Any labels added to the list of pre-defined labels will be available from the drop-down box that 

appears when a user labels a version in the Change Log (see Section 10.2.4 for details). 

 

Figure 54: The pre-defined labels dialog. 

11.1.3 Exporting the Template 

To create a template tree, select ‘Export as Template...’ from the File menu.  Your tree will be 

saved with the .tem file ending, instead of the usual .tes ending.  If you wish, you may enter a 

password to protect the tree structure.  If you choose not to specify a password then users of 

trees derived from the template will be able to change its parameterisation and structure 

(adding/removing nodes) freely.  If a password is applied, then users will only be able to enter 

confidence values, add to the audit trail and produce plots and reports freely.  All other features 

will be restricted by the password. 

The .tem file can then be distributed to users who are working on individual projects.  Note that 

the .tem file cannot be opened directly like a tree.  It can only be used to generate new trees that 
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derived from that template. Therefore, if after creating a template further updates need to be 

made, these should be made to the original .tes file. A new template can then be exported. 

Note that any confidence values and reference documents attached to nodes in the tree will be 

removed from the exported template file, leaving just the tree structure, parameters and 

supporting guidance documents.  Users of a template are expected to fill in their own confidence 

values. 

11.2 Deriving a Tree from a Template 
If you have been provided with a template file (ending in .tem), start a new tree based upon it by 

launching TESLA and selecting ‘New from Template...’ from the ‘File’ menu.  Select the template 

file (.tem) from the file browser.  The derived tree will open in a new tab, and can be worked 

upon and saved in the usual manner. 

If the template designer has locked the tree structure with a password, you will be prompted for 

this password if you try to make any modifications other than those related to the input of 

confidence values.  If you have been supplied with the password then you only need enter it 

once per session to unlock the tree structure.  

11.2.1 Viewing Template Guidance 

The ‘Template Guidance’ tab described in Section 11.1.1 is not available in trees that are 

derived from a template, but any information entered in this tab by the template designer is 

visible instead on the ’Evidence’ tab.  Guideline confidence values are shown as washed-out 

green and red bars in the Italian flag as shown in Figure 55.  Click the ‘Show Guidance’ button to 

slide out the Template Guidance pane on the right of the dialog; here the explanation for the 

guideline values is shown in the ‘Explanation’ tab; the ‘Supporting Documentation’ tab shows a 

list of documents added by the template designer.  Double-click a document (or select and press 

‘View’) to open it in the default application for that document format. 

 

Figure 55: The Template Guidance pane on the ‘Evidence’ tab displays any guideline 
information entered by the template designer. 
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12 Comparing a Portfolio of Trees 
ESL allows the decision maker to study one hypothesis in detail.  There are occasions when it is 

desirable to compare multiple trees (e.g. if each tree represents a different option), or multiple 

versions of the same tree (e.g. to view how confidence has varied over time).  TESLA provides a 

portfolio tool for this purpose, which is explained in this section. 

12.1 Comparable Trees 
TESLA’s portfolio tool allows multiple trees to be compared.  Those trees may be in separate 

files (see Section 12.2) or may be multiple versions of a single file (see Section 12.3).  In order 

to compare the trees TESLA checks that they represent the same hierarchy of hypotheses, as 

defined by the hypothesis titles.  So, starting from the root hypothesis, the hypothesis titles must 

match, the titles of their children must match and so on.  For a given parent, it does not matter if 

the child hypotheses are ordered differently across the different trees however. 

When launching a portfolio TESLA will establish what differences in parameterisation there are 

between the trees, such as changes in logic, sufficiency, dependency, or simply in hypothesis 

descriptions and will warn the user about them on launch.  See Figure 56 for an example. 

 

Figure 56: A warning about differences in the parameterisation of trees in a portfolio 

12.2 Multiple Files 
It is possible to compare multiple trees, stored in multiple .tes files, using the portfolio tool 

provided: 

 that every tree was based on the same template file, or on no template file; and 

 that every tree has the same structure as defined in Section 12.1. 

To open a portfolio of decision tree files, launch TESLA and select ‘Open Portfolio’ and then 

‘From Files...’ from the File menu.  You will then be asked to select the files you wish to open.  

These files must all be located in the same directory on the computer. Multiple files can be 

selected simultaneously by holding down the Ctrl key whilst clicking. 

If there are differences in parameterisation between the trees, a summary of the changes will be 

provided first. (See Section 12.1.) You will then be presented with a dialog (Figure 57) asking 

the order in which to display the trees in the portfolio tool.  Arrange the trees in the order you 

require by selecting each decision in turn and using the ‘Move Up’ and ‘Move Down’ buttons to 

re-order them.  When finished, press ‘OK’. 
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Figure 57: Selecting the order of the trees in the portfolio. 

The portfolio tool will then open, as shown in Figure 58.  Here we have compared multiple trees, 

each one representing a judgement on the weather conditions on a different day of the week. 

We can only say whether it is cloudy or raining for the current day (Monday), thus there is much 

uncertainty in the lower half of the tree.   

Each tree in the portfolio is represented by a small, vertically-orientated “Italian flag” image.  The 

number above the image can be used in conjunction with the legend to determine which tree is 

which.  The order of the trees can be changed at any time via the ‘Options’ item in the ‘Tree’ 

menu.  Double-click any tree in the legend to open it up in a separate tab - however please note 

that any changes made to a tree will not be reflected in the portfolio tool, unless it is closed and 

re-opened. 
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Figure 58: The portfolio tool, comparing multiple decision trees contained in separate files. 

12.3 Multiple Versions 
The portfolio tool can also be used to view multiple versions of a single decision tree (see 

Section 10 for a discussion of version control).  To open a set of versions from a single file, 

launch TESLA and select ’Open Portfolio’ and then ‘From Single File...’ from the ‘File’ menu.  

You will then be asked to select the file you wish to open the versions from.  TESLA will 

compare all historic versions of the tree that have a hypothesis structure that is comparable with 

the most recent version. (See Section 12.1.) 

Once the file is selected, a list of versions found within that file will be displayed.  Select the 

versions you wish to include in the portfolio and press ‘OK’.  If there are differences in 

parameterisation between the chosen trees, a summary of the changes will be provided.  Finally 

you will be asked to select the order of the versions in the portfolio, as shown in Figure 57.  This 

can be changed at any point from the ‘Options’ item in the ‘Tree’ menu. 

A portfolio of versions behaves in a similar fashion to a portfolio of multiple trees (Section 12.2). 
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12.4 Plots 

12.4.1 Tree Plot 

The tree plot for the portfolio behaves as described in Section 7.1 for standard trees. 

12.4.2 Single-Hypothesis Ratio Plot 

The Single-Hypothesis Ratio plot is similar to the standard Ratio plot (see Section 6.3) but only 

includes a single hypothesis, and displays that hypothesis for each of the trees/versions in the 

portfolio on the same plot.  For example, Figure 59 shows a Single-Hypothesis Ratio plot for the 

root hypotheses of the portfolio of trees shown in Figure 58. 

To draw a Single-Hypothesis Ratio plot, select the node to plot in the Tree View display and 

select ’Single-Hypothesis Ratio Plot‘ from the ‘Plots’ menu in the main TESLA window. 

 

Figure 59: A single-node ratio plot, generated by the portfolio tool.  This shows a single selected 
node for each tree/version in the portfolio. 

12.4.3 Ratio Plots for All Trees/Versions 

Ratio plots can also be produced for all trees/versions in the portfolio, as shown in Figure 60.  A 

single Ratio plot is shown for each tree/version and displayed in a grid; each Ratio plot shares 

the same legend.  This enables the user to easily compare Ratio plots across all trees/versions 

in the portfolio. 

To draw Ratio plots for all trees/versions in the portfolio, select ’Ratio Plots for all Trees‘ from the 

‘Plots’ menu. 
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Figure 60: A grid of Ratio plots for each tree/version in the portfolio. 

12.4.4 Tornado Plots for All Trees/Versions 

Similarly Tornado plots (see Section 6.4) can be produced for each tree/version in the portfolio.  

The Tornado plots are displayed in a grid (Figure 61) and share a single legend, which is shown 

at the bottom.  Note that in order for the trees to share a single legend, the nodes are not 

ordered by rank (since this may change between trees/versions) but by position in the tree, 

using the same numbers as the ratio plots.  Numbering starts at 2 rather than 1 since 1 

represents the root node, which is only displayed on a Ratio plot. 

To draw Tornado plots for all trees/versions in the portfolio, select ’Tornado Plots for all Trees‘ 

from the ‘Plots’ menu. 



 

 59 

 

 

Figure 61: A grid of Tornado plots for each tree/version in the portfolio. 

12.5 Summary Reports 
Summary Reports can be generated from a portfolio in the same manner as described in 

Section 7.2 for standard trees.  Two options are available; a single report summarising the 

portfolio as a whole (choose ’Create Report‘ from the ‘Reports’ menu), or multiple reports, one 

for each tree in the portfolio (choose ’Create Reports for All Trees in Portfolio‘ from the ‘Reports’ 

menu).  This latter option will produce a report that is identical to the standard report for an 

individual tree. 
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Appendix A: The ESL Propagation Algorithm 

Introduction 
ESL is an information propagation calculus (Davis & Hall, 2003) developed from Interval 

Probability Theory (Cui & Blockley, 1990).  It considers an open world view, in which information 

can be incomplete or even contradictory.  Classical probability theory considers two-value logic, 

whereby the probability of a hypothesis being true or false is known with certainty.  Associating a 

user’s confidence in the hypothesis being true with the probability of it being true gives a closed 

world perspective, with confidence for and confidence against being complementary concepts 

(i.e. confidence for + confidence against = 1). 

ESL extends this to allow for a user’s uncommitted belief, which can be identified with the 

uncertainty in the probability that the hypothesis is true or false (i.e. confidence for + 

uncommitted belief + confidence against = 1).  In this case the probability that the hypothesis is 

true is modelled as being bound by the range 

(confidence for) < probability < 1 - (confidence against) 

with the confidence for and against being used to define the lower and upper bounds of the 

probability range. 

Confidence for and confidence against are defined independently, each ranging from 0 to 1, with 

uncommitted belief thus taking a value from –1 to 1.  An uncommitted belief of 1 implies that 

there is no confidence that the hypothesis is true or false – or that the probability of the 

hypothesis being true is completely uncertain. A negative value indicates confidence for and 

against totalling more than 1 – which is not compatible with a physical range of probabilities.  i.e. 

there is a conflict in confidence values.  

The three values of confidence for, uncommitted belief and confidence against are often 

represented in the form 

[ confidence for, uncommitted belief, confidence against ], 

for example [ 0.34, 0.45, 0.21 ]. 

Derivation of the Propagation Algorithm 
The ESL algorithm propagates the probability range for each hypothesis up the hierarchy of 

hypotheses.  Cui and Blockley (1990) showed that the upper and lower bounds of the range of 

probabilities for each hypothesis can be treated independently as a point probability. Therefore, 

in the following we consider the propagation of a single probability, while understanding that this 

is applied to both the lower and upper bound of the probability range for each hypothesis. 

Consider a parent hypothesis, H, with two child hypotheses labelled C1 and C2.  The relationship 

between the parent and its children is demonstrated with a Venn diagram in Figure 62.  Here the 

space where each hypothesis is true is depicted by a differently coloured circle.  The probability 

that the parent hypothesis is true, P(H), is calculated from the probabilities of its children being 

true, and is represented by the degree of overlap with H, outlined in red in the figure. 
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Using the Venn diagram it is easy to write down an expression for P(H) in terms of intersections: 

)))()(()(())()(())()(()( 2121 CPCPHPCPHPCPHPHP   (A1) 

Note that, since we are dealing with probabilities, the areas outside a circle are areas where the 

probability of that hypothesis being true is zero.  The overlap that occurs when the probabilities 

of C1 and C2 being true are both non-zero is accounted for in the third term of the above 

equation. 

Cui & Blockley (1990) define the degree of dependency between two sets A and B as: 

),min( BA

BA
 , (A2) 

i.e. the fraction of the smaller of the two sets which overlaps with the other set.  There are three 

special values of the degree of dependency that concern us: 

0  A and B are mutually exclusive, i.e. 0BA .   

1   A and B are totally dependent, i.e. BA  or AB  . 

),max( BA   A and B are statistically independent, i.e. )()|( APBAP   where )|( BAP  is the 

probability of A given that B has already occurred (a conditional probability). 

If ρ = 0 (mutual exclusivity), this means that P(C1) and P(C2) cannot overlap and thus a situation 

cannot arise where both have non-zero probabilities of being true - a situation we should 

discount.  The minimum value of ρ that we can accept is max(P(C1), P(C2)), corresponding to 

statistical independence; the probability of C2 being true has no bearing on the probability of C1 

being true. 

Therefore a new parameter, D, is introduced (e.g. Bowden, 2004) which is simply known as the 

dependency.  This is related to the degree of dependency ρ by the expression 

),1(
IND

DD    (A3) 

Figure 62: Venn diagram illustrating the ESL algorithm. 
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where 
NDI

  is the value that ρ takes when the overlapping sets are statistically independent.  By 

restricting D to values between 0 and 1, ρ is restricted to values between ρIND (statistical 

independence) and 1 (total dependence).  The value of D is set by the user in TESLA. 

Using the expression (A2) for the degree of dependency, (A1) can be written as 

))()(),()(min())()(())()(()( 2121 CPHPCPHPCPHPCPHPHP   , (A4) 

where ρ is given by 

))()(),()(max()1(

))()(),()(min(

))()(())()((
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 (A5) 

Here we have used equation (A3) and the definition of a conditional probability to obtain the last 

line: 

 )(

)(

)()(
)(

AP

BP

BPAP
BAP






   (statistical independence) (A6) 

The intersects )()( 1CPHP  and )()( 2CPHP  are simply equal to some fraction of P(C1) and 

P(C2) respectively (as shown in Figure 62).  If these fractions are denoted by w1 and w2 then 

equation (A4) can be written as: 

)).(),(min()()()( 22112211 CPwCPwCPwCPwHP   (A7) 

In ESL, the fractions or weightings
‡
 wi are known as the sufficiency – a fully sufficient hypothesis 

has a weighting of one.  The values of the weightings are set by the user, guided by expert 

judgement.   

The degree of dependency, ρ, (as given by equation (A5)) can also be written using the 

sufficiency: 
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In the final step of (A8), we have used the fact that P(C1|C2) = P(C1) if C1 and C2 are statistically 

independent.  Note that, when integrated into equation (A7), the denominator of the term on the 

                                                        

‡
 In actual fact, these weightings are conditional probabilities, as can be seen from equation (A6). 
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right of the sufficiency cancels, avoiding the singularity that might otherwise occur when the 

minimum of P(C1) and P(C2) is zero.  

The derivation above can readily be extended to n child hypotheses; in that case equations (A7) 

and (A8) can be generalised to: 
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where, if S = { i, j,…},  

 )(min
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The Necessity Heuristic 
The necessity is taken into account via a heuristic that governs the whole propagation process.  

The idea of this heuristic is to make sure that if any necessary nodes ‘fail’ then the failure gets 

reflected upon the parent node.  In general, the confidence values (both for and against) are 

propagated directly from the failing node.  However, if the confidence values calculated from the 

propagation algorithm above result in the parent node failing anyway, then these values are 

used instead provided that the confidence for is greater than that of all the failing necessary 

child nodes. 

Thus, firstly the confidences for and against are calculated for a node using the propagation 

algorithm described above.  Then the following rules are applied: 
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if, for any necessary node, the node fails  

{ 

if the parent’s calculated confidence against is even greater than the largest  

of these for all necessary child nodes 

{ 

propagate confidences for and against as calculated 

} 

else 

{ 

propagate the confidence values of the necessary child node with the  

largest confidence against (if more than one necessary child nodes  

have the same value of confidence against, propagate the values of 

the node with the smallest value of confidence for) 

} 

} 

else 

{ 

propagate confidences for and against as calculated 

} 

Advanced Evidence Support Logic (AESL) 
The propagation method employed by TESLA is a direct extension of ESL (described in the 

preceding section), called Advanced Evidence Support Logic.  See Bowden (2004) for full 

details.   

Evidence Coverage and Quality of Evidence 

As well as being able to specify the confidence values directly for an AESL leaf node, the user 

may wish to break the confidence values down into component the parts: Face Value of 

evidence, Evidence Coverage and Quality of Evidence.  These are multiplied to give the overall 

confidence.  That is, 

iiii aqkE  , 

where ki, qi and ai are the Evidence Coverage, Quality of Evidence and Face Value of evidence 

respectively for hypothesis i, each taking a value between 0 and 1.  The confidence Ei is then 

used in all further calculations. 

Any Sub-Hypothesis Sufficient 

This represents a situation where any and every single child node is sufficient to ensure success 

(or failure) of a given node, but with no mutual support from confidence arising from other child 

nodes (as distinct from applying sufficiencies of ‘1’ for each sibling).  This is modelled by direct 

propagation of the maximum confidence values from among the n child nodes, i.e. 

 nH EEE ,,max 1   

All Sub-Hypotheses Necessary 

This represents a situation where all the child nodes are required in unison to ensure success 

(or failure) of the parent.  This is achieved by propagating the minimum confidence values from 
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among the n child nodes, with no mutual support from confidence arising from other child nodes, 

i.e. 

 nH EEE ,,min 1   

Therefore, if these alternative propagation procedures are used for both types of confidence 

then any dependence value(s) for that node will become redundant, along with any 

sufficiency/necessity values for its child nodes. 

 

 

 

 



 

 66 

Appendix B: Glossary of Terms 

Term Definition 

AESL Advanced Evidence Support Logic, a method of propagation and an 
extension of ESL. 

Branch A section of the tree, running from a given node to all leaf nodes 
connected below it. 

ESL Evidence Support Logic, a method of propagation. 

Confidence For A measure of the confidence in a hypothesis being true, based on the 
available evidence. 

This is measured on a scale from 0 to 1 where 0 represents no confidence 
in support of the hypothesis being true and 1 represents complete 
confidence that the hypothesis is true. 

Confidence Against A measure of the confidence in a hypothesis being false, based on the 
available evidence. 

This is measured on a scale from 0 to 1 where 0 represents no confidence 
in support of the hypothesis being false and 1 represents complete 
confidence that the hypothesis is false. 

Face Value of 
Evidence For 

This field only becomes available when using the advanced evidence 
input controls.  It can be considered a "best estimate" for whether the 
hypothesis is true, and should be set such that the face values of 
evidence for and against sum to unity.  The evidence coverage and 
quality fields can then be used to express the uncommitted belief for the 
chosen face value. 

Face Value of 
Evidence Against 

This field only becomes available when using the advanced evidence 
input controls.  It can be considered a "best estimate" for whether the 
hypothesis is false, and should be set such that the face values of 
evidence for and against sum to unity.  The evidence coverage and 
quality fields can then be used to express the uncommitted belief for the 
chosen face value. 

Child A node that has a parent (i.e. any but the root node). 

Conflict Conflict occurs if confidence for + confidence against > 1 and indicates 
that there is definitely over-confidence in the available evidence.  Action 
should be taken to determine why there is conflict between the confidence 
in the evidence for and against.  It may indicate that some of the evidence 
is not as sound as previously thought.    

Dependency A value between 0 and 1 related to the amount of overlapping evidence 
between two or more sibling hypotheses. 

Failure Failure of a node is determined by its confidence values; depending on 
the failure definition, a failed node has either confidence against > 0.5 or 
confidence for < 0.5. 

Hypothesis A statement to be tested; linked to a node in a decision tree. 

Leaf A node in the tree with no children; leaf hypotheses are the only 
hypotheses in the tree where evidence can be input by the user. 

Necessity If a node is a necessity, the success of its parent depends on the success 
of the node. 

Node Nodes in the decision tree represent a hypotheses. 

Parent A node with one or more children (i.e. any but a leaf node). 

Propagation Movement of information (i.e. confidence in the available evidence) 
through the tree from the leaves to the root. 
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Term Definition 

Root A node with no parent. After propagation the root node provides a gives 
the confidence and uncertainty in the main hypothesis associated with the 
decision. 

Siblings Nodes that share the same parent. 

Success Success of a node is determined by its confidence values; depending on 
the failure definition, a successful node has either 
confidence against < 0.5 or confidence for > 0.5. 

Sufficiency A value between 0 and 1 indicating the weight that should be given to the 
confidence associated with a hypothesis when propagating the values up 
the tree. 

Tree A collection of hypothesis nodes representing a decision. 

Uncommitted belief Uncommitted belief can be expressed numerically as: 
 

1 – confidence for – confidence against 
 
and takes values in the range 0 to 1.  When positive it represents 
uncertainty arising from lack of evidence or from lack of confidence in the 
available evidence.  If the uncertainty is negative then this corresponds 
instead to a conflict of evidence.     
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